
Book 1 
Chapter 1 

 
A. Fill in the blanks with the help of the words given in the box.  
1. time 2. humans,  3.electricity, fuels  4.computer 
B. Write true (T) or false (F).  

1.​F, 2. T, 3. F, 4. T 
C. Tick (✓) the right answer.  

1.​(i) fuel 3 2. (ii) All of these 3. (ii) human 
D. Answer the following questions.  
1.​ (i) It never gets tired. (ii) It never makes mistakes. 
2.​ (i) car (ii) aeroplane. 
3.​ (i) Computer (ii) washing machine. 
4.​ (i) sewing machine (ii) bicycle. 
 
 

 
 

 



Chapter 2. 
A. Encircle the objects which are not the parts of a computer.  
 

 

 B. Fill in the blanks with the help of the words given in the box.  
1.Computer 2. Printer 3. Keyboard 4. CPU 
C. Tick (✓) the right answer.  
1.Four 2.Mouse 3.Monitor 4.104 

D. Answer the following questions.  
1.(i)Monitor (ii)CPU (iii)Keyboard (iv)Mouse 
2. A monitor looks like a TV screen. It shows the work that we do on a 
computer. It displays pictures, text, movies etc. on screen. It is also 
called a VDU (Visual Display Unit). The front portion of the monitor is 

called the screen on display.  
3. Keyboard looks like a typewriter. It helps us to give instructions to a 
computer. A keyboard has many buttons called keys on it. A standard 
keyboard has 104 keys. It is used to type letters, words and numbers.  
4. Printer, Scanner, Speaker and Headphones. 

 



Chapter 3 
A. Fill in the blanks with the help of the words given in the box.  
1. Television, computer 2. Speakers, headphones 3. Chess, solitaire 4. 
home 5. teach. 
B. Look at the pictures given below. Circle the pictures which show 
the different uses of a computer.  
Do yourself 
C. Write true (T ) or false (F).  
1. F 2. F 3. T 4. F 5. F 
D. Answer the following questions.  
1. Solve sums, Type documents, listen to music, play games, draw 
pictures, send emails. 
2. At home, in hotels and resorts, at airports, in hospitals, in banks, in 
schools. 
3. In School computers are used to teach students and to maintain 
student records. 
4. We can watch movies and browse our pictures on a computer.  

 



Chapter 4 
 

A. Fill in the blanks with the help of the words given in the box.  
1. hardly 2. Switch  3. Computer 4. pull 5. clean. 
B. Write true (T ) or false (F).  
1. F 2. T 3. F 4. T  
C. Tick (✓) the right answer.  
1.(i) 2.(ii) 3.(ii) 4.(i) 

D. Answer the following questions.  
1. Always clean your computer with a dry cotton cloth. 
2. Always keep the computer mouse on the mousepad. 
3. (i)Don’t press the keys of the keyboard hard 
(ii)  don’t play with the buttons on monitor 
(iii)  don't touch or pull the wires and cables of the computer 
4. (i) Keep your computer room/ lab clean  and dust free 
(ii)   share the computer with others 
(iii)   cover the computer when not in use 
 

Book 2 
 

Chapter 1 
A. Fill in the blanks with the help of the words given in the box.  
1. electronic 2. correct  3. songs, movies 4. large 
B. Write true (T ) or false (F).  
1. T 2. T 3. F 4. T  
C. Tick (✓) the right answer.  
1.(iii) 2.(i) 3.(i) 4.(iii) 

D. Answer the following questions.  
1. Offices and Schools. 
2. (i) A computer needs electricity to run, humans don’t need 
electricity. 
(ii) A computer can never make any mistakes, but humans can make 
mistakes. 
3. (i)Reliable: A computer is reliable and it does not make any  
mistakes. 



(ii) Speed: Computer is very fast. It can perform a large number of 
calculations within seconds without any mistakes. 
4. Small computer that can be easily kept, our lap is called a laptop. It 
works with the help of batteries that can be charged with electricity. 
It is small in size and light in weight. So, it can be carried easily from 
one place to another. 
 
HOTS 
1. Scientist, 2. Teacher 1. Cashier/Banker, 2. Shopkeeper. 
 

Chapter 2 
A. Fill in the blanks with the help of the words given in the box.  
1. Four 2. two  3. printer 4. speaker 
B. Write true (T ) or false (F).  
1. T 2. T 3. F 4. F  
C. Tick (✓) the right answer.  
1.(iii) 2.(ii) 3.(i) 4.(iii) 

D. Answer the following questions.  
1. A computer has four main parts- The monitor, keyboard, mouse 
and CPU without which it cannot work. 
2. Mouse is used to point, move and select any item on the monitor. 
It helps us to play games and draw pictures. 
3. A keyboard is used to enter data into a computer. It has many 
buttons on it, these are called keys. It is used to type letters, words, 
numbers and special symbols. A standard keyboard has 104 keys. 
4. UPS(Uninterrupted Power Supply) is used to supply power to the 
computer in case of power failure. 
 

Chapter 3 
A. Fill in the blanks with the help of the words given in the box.  
1. instructions 2. processing  3. monitor 4. output 
B. Write true (T ) or false (F).  
1. T 2. F 3. T 4. F  
C. Tick (✓) the right answer.  
1.(i) 2.(ii) 3.(ii) 



D. Answer the following questions.  
1. A  computer works in three basic steps- input, process and output 
it is known as the IPO cycle.(Input-Process-Output) 
2.  Monitor and printer are two examples of output devices. 
3. Mouse and keyboard are two examples of input devices. 
4.  The process of changing the entered data into meaningful 
information is called processing. 
 

Chapter 4 
A. Fill in the blanks with the help of the words given in the box.  
1. 104 2. 26  3. spacebar 4. navigation 5. left 
B. Write true (T ) or false (F).  
1. F 2. T 3. F 4. F 5. F  
C. Tick (✓) the right answer.  
1.(ii) 2.(i) 3.(ii) 4. (ii) 
D. Answer the following questions.  
1. The keyboard is a device that consists of many keys. It has a 
number of buttons that are called keys. A keyboard has different keys 
which are used to type letters, numbers, symbols etc. We can type on 
a computer by pressing the keys on the keyboard. It is an input 
device whatever we type on the keyboard appears on the monitor. 
2.   Delete key is used to erase the characters typed on the right of 
the cursor, it means when the Delete key is pressed, it erases the 
characters type on the right of the cursor. 
3. A keyboard has four arrow keys on the right side of a keyboard that 
help to move the cursor on the screen. 
4.  Tab key is used to move the cursor towards right by many spaces. 
The Tab key is present at the left side on a keyboard. 
5.  The spacebar key is the longest key on the keyboard. It is used to 
leave gaps or spaces between words. 
 

 



Chapter 5 
A. Fill in the blanks with the help of the words given in the box.  
1. Single-click 2. Ball  3. right-click 4. left-click 
B. Write true (T ) or false (F).  
1. T 2. F 3. F 4. T  
C. Tick (✓) the right answer.  
1.(ii) 2.(iii) 3.(iii) 4. (i) 
D. Answer the following questions.  
1. A mouse is a part of a computer which looks like a real Mouse. It is 
small in size and has a tail which is attached to the CPU. It is a 
pointing device.  
A mouse helps us to move the pointer, select items and draw pictures 
on the computer screen. 
The left button is used for left and the right button is used for right 
click 
2.   When we press the left mouse button once and release it, it is 
called single-click. It is generally used to select an item on the 
monitor when an item is selected, its colour changes. 
3. When we press the left button of the mouse twice quickly and 
release it. This is called double-click. It is used to open a document or 
a window. 
4.  A wireless mouse is not attached to the computer through a wire. 
It uses signals to communicate with the computer. 
5.  It is used to change the position of an item on the screen. Moving 
a mouse while keeping the left button pressed is called Dragging.



Chapter 6 
A. Fill in the blanks with the help of the words given in the box.  
1. Flash Drive 2. permanent  3. system unit 4. compact disk-read only 
memory 
B. Write true (T ) or false (F).  
1. F 2. T 3. F 4. T  
C. Tick (✓) the right answer.  
1.(i) 2.(iii) 3.(i) 4. (i) 
D. Answer the following questions.  
1. Whatever we learn in our school is stored in our mind. A computer 
also stores all of its work (data) that it has done. Once we store our 
work on a computer it will never get lost until we delete it.  
The devices which are used in storing the data are called storage 
devices. 
2.   Most commonly used storage devices are: Hard Disk, CD Rom, 
Floppy Disk, Pen Drive. 
3. The hard disk is a small magnetic disk present inside the system 
unit. It is fixed inside the CPU and therefore called internal memory 
of a computer. 
The hard disk is a permanent storage device. It can store large 
amounts of data. It is also known as HDD( Hard Disk Drive).  
4.  (i)CD-ROM - Compact Disk-Read Only Memory 
(ii) DVD- Digital Versatile Disk 
5.  Pen Drive is a very small portable and high-capacity storage 
device. The storage capacity of a pen drive is even more than a 
CD-ROM or floppy disk. We can read or write data on a pen drive by 
attaching it to the port, called the USB port in the CPU. Pen Drive is 
also known as Flash Drive.  
 

 



Chapter 7 
A. Fill in the blanks with the help of the words given in the box.  
1. Ribbon 2. Fill with color  3. drawing area 4. typing text 
B. Write true (T ) or false (F).  
1. F 2. F 3. T 4. T  
C. Tick (✓) the right answer.  
1.(ii) 2.(i) 3.(ii) 4. (ii) 
D. Answer the following questions.  
1. Microsoft Paint is a program used for drawing and editing pictures. 
2. Some important parts of paint window are: 
(i)  title bar (ii)  quick access toolbar (iii)  ribbon (iv)  tab (v)  file tab 
(vi)  groups (vii)  drawing area  
3.  The brush tool is used for drawing lines and curves that have 
different appearance and textures.  Different artistic brushes are  
available which can be used to draw free-form and curved lines that 
have different effects. 
4.  It is very important to save our pictures(work) so that we do not 
lose our work. We can save the picture as a file. Let us see the steps 
to save our picture: 
 Step 1. Click on the File tab → Save option 
 Step 2. Save as dialogue box will appear 
 Step 3. Type the name in the File name box 
 Step 4. Click on the Save button. 
 

 



Chapter 8 
A. Fill in the blanks with the help of the words given in the box.  
1. WordPad 2. Work area  3. Font size 4. Font family 5. formatting 
B. Match the following:  
1. (iii) 2. (i) 3. (ii) 4. (v) 5. (iv) 
C. Tick (✓) the right answer.  
1.(ii) 2.(iii) 3.(iii) 4. (ii) 
D. Answer the following questions.  
1. Microsoft Paint is a program used for drawing and editing pictures. 
2. Some important parts of paint window are: 
(i)  title bar (ii)  quick access toolbar (iii)  ribbon (iv)  tab (v)  file tab 
(vi)  groups (vii)  drawing area  
3. The brush tool is used for drawing lines and curves that have 
different appearance and textures.  Different artistic brushes are  
available which can be used to draw free-form and curved lines that 
have different effects. 
4. It is very important to save our pictures(work) so that we do not 
lose our work. We can save the picture as a file. Let us see the steps 
to save our picture: 
 Step 1. Click on the File tab → Save option 
 Step 2. Save as dialogue box will appear 
 Step 3. Type the name in the File name box 
 Step 4. Click on the Save button. 
 

 



Book 3 
 

Chapter 1 
 

A. Fill in the blanks with the help of the words given in the box.  
1. hardware 2. Operating System  3. Software 4. Application software 
5. ALU 
B. Write true (T ) or false (F).  
1. F 2. F 3. T 4. T 
C. Tick (✓) the right answer.  
1.(ii) 2.(i) 3.(ii) 4. (ii) 
D. Answer the following questions.  
1. When we play games on a computer, we use a joystick. It makes it 
easier to control how the game moves. It detects movements in two 
directions. It has a stick that transmits signals. 
2. A printer is used to print out the results of the work done by a 
computer. We can use a printer to print documents, drawings, images 
etc. in black and white as well as in colour. The information printed 
on paper is called the hard copy or a printout. There are two main 
types of printers: Laser printer and Inkjet Printer. 
3.The Central Processing Unit (CPU) is the processing device that 
takes in data and sends the results to the output devices. The CPU is 
a chip that is put inside the CPU box. It is also called the "brain of a 
computer" because it does all the work. A CPU is further divided into 
the ALU(Arithmetic and Logic Unit), CU(Control Unit) and 
MU(Memory Unit). 
4. The main difference between System and application software is: 
 

System Software​  Application Software 

It controls and manages all 
activities of a computer. 

It does a specific type of work. 
like: writing a letter, sending an 
email etc 

Example : Operating System Example: MS Word 



Chapter 2 
 

A. Fill in the blanks with the help of the words given in the box.  
1. taskbar 2. search 3. Operating 4. Recycle Bin 
B. Write true (T ) or false (F).  
1. T 2. F 3. T 4. F 
C. Tick (✓) the right answer.  
1.(iii) 2.(i) 3.(iii) 4. (iii) 
D. Answer the following questions.  
1. The operating system is the most important part of a computer. A 
computer is of no use without an operating system. It is a software 
that tells a computer how to work. It controls the working of 
different hardware devices attached to the computer and also keeps 
a record of all the programs onto which you work. 

Microsoft Windows, Linux and Macintosh OS are some examples of 
operating systems. Microsoft Windows is the most popularly-used 
operating system. 

2. It is one of the most popular system software in the world. It is 
developed by Microsoft Corporation, USA. It allows users to work in a 
graphical platform. There have been different versions of Windows 
over the years such as Windows 7, Windows Vista, Windows XP, 
Windows 10 and Windows 11, presently. 

 

3.The following are the components of windows 10: 
1. Desktop Area: This is used to hold files/folders and applications. 
From the desktop you can directly access the program. 
2. Desktop Icons: The icons on the desktop consist of applications. By 
default, you have a few icons on your computer and you can add your 
own icons with it.  

3. Start Button: It is a very important desktop item. It is used to 
perform many activities, like starting an application, searching files 
and folders and shutting down the computer. When you click on the 



Start button, a menu appears on the screen. This is called the Start 
menu.  

4. Taskbar: There is a dark narrow band under the desktops called 
taskbar. It shows the titles of opened files, notification panel and 
date & time.​ ​ ​ ​ ​  

5. Search box: You use this box to search for anything on your PC.​  

6. Notifications area: This part of the taskbar displays various system 
icons such as networking, sound and power, as well as notifications 
issued by Windows. 

7. Task View: Task View is a feature of Windows 10 that allows you to 
organize your applications across multiple virtual desktops.  

4. The icons on the desktop consist of applications. By default, you 
have a few icons on your computer and you can add your own icons 
with it.​ ​ ​ ​ ​ ​  

Common icons on the desktop are : 

Recycle Bin: Recycle Bin stores the files that we have removed or 
deleted from our computer.​​ ​ ​ ​ ​  

Network: We can use this icon to check if we are connected to a 
network, such as an internet.  

This PC: We can view the files and folders saved on our computer 
using the This PC icon. Clicking on this icon opens the File Explorer 
application that shows us the various locations on our computer and 
the files and folders stored in it.  



Chapter 3 
 

A. Fill in the blanks with the help of the words given in the box.  
1. magnifier 2. free form 3. pencil 4. polygon 
B. Write true (T ) or false (F).  
1. F 2. F 3. T 4. T 
C. Tick (✓) the right answer.  
1.(i) 2.(i) 3.(ii) 4. (i) 
D. Answer the following questions.  
1. (i) Text : It is used for adding text to a selected portion. 
(ii) Fill with color : It is used for filling shapes with colours. 
(iii) Color picker : It is used for selecting the colour of any object. 
(iv) Magnifier : It is used for enlarging and reducing the view of your 
drawing. 
 
2. Color Picker Tool is a very useful tool. It is used to select a colour 
from an existing object and fill it to any other object. We can use it by 
following the steps below: 
Step1: Draw an object. Say a rectangle. 
Step2: Colour the rectangle using Fill with color tool. 
Step3: Now draw a star.  
Step 4 : Select the Color picker tool and click inside the rectangle to 
copy the colour.  
Step5: Move the mouse pointer and click inside the star to fill the 
same colour in it.  
 
3.Free-form selection is used to select an irregular shape area of the 
image. 
To use free form selection. Follow the steps given below :​
 
Step 1 : First, left click on the Select from the Image group and 
choose Free-form selection.​
 Step 2 : Now, click and drag to select the area of the drawing. 
Release the mouse button, a dotted box appears around the 
selection.  



 
4. The Cut option is used to shift the image from one location to 
another location. The steps to use Cut command are given below : 

Step1: Select the required part of the drawing. 

Step2: Click on the Cut option from the Clipboard group. 

Step3: The selected part is cut off from the drawing. 

Step4: Now you can use the Paste command to paste the cut part on 
the drawing.  

5. We can resize or skew the whole or selected part of the picture 
horizontally or vertically. The picture becomes smaller or wider using 
resize and it appears in a slanting position using the skew option. To 
do this follow the given steps :  

Step1: Select the area by using Select tool. 

Step2: Select the Resize option in the Image group on the Home tab. 

Step3: Specify the Resize in percentage or pixels.​ ​ ​ ​  

Step4: Specify the skew in degree according to your requirement. 
Click OK.  

6. The magnifier tool is used to get a Zoom in or Zoom out view of 
the picture in Paint. We use the Zoom in and Zoom out options to see 
a larger and a smaller view respectively of the entire picture.  

To use the Magnifier tool follow the steps given below : 

Step1: Left click on the Magnifier tool from Tools group. 

Step2: Move the mouse pointer over the drawing area. 

Step3: Left-click gives a Zoom in (closer view) and Right-click gives a 
Zoom out view.  



7. The Undo ..... and Redo ..... commands are available on the Quick 
Access Toolbar. Undo command is used to cancel the last action Redo 
command is used to restore the effect of undo command.  



Chapter 4 
 

A. Fill in the blanks with the help of the words given in the box.  
1. title bar 2. quick access 3. status bar 4. ctrl+p 
B. Write true (T ) or false (F).  
1. T 2. T 3. F 4. T 
C. Tick (✓) the right answer.  
1.(iii) 2.(iii) 3.(ii) 4. (i) 
D. Answer the following questions.  
1. Word-processing software allows us to create documents that can 
have both text and pictures. We can also change the appearance of 
the text to make documents attractive with word-processing 
software.  

Many word-processors have been developed to make typing on the 
computer easy. Some of them are Microsoft Word, WordPad and 
Open Office Writer.  

2. The features of word-processing software are:​
 ¤ We can type anything like stories, letters, reports, etc.​
 ¤ We can highlight important words or lines in the document. ¤ We 
can also add pictures in the document.​
 ¤ We can check spelling and grammatical mistakes.​
 ¤ We can make changes in the text while typing or after typing. ¤ We 
can copy and move the text.​
 ¤ We can put margins on a page.​
 ¤ We can save the document for future use.  
​ ​ ​ ​ ​  
3. MS-Word is one of the most popular word-processing software. 
Microsoft Word is a part of the MS Office package. MS-Word is used 
to type letters, stories, poems and create many other documents.  
 
4. To create a new document, follow the steps given below :  

Step1: Click on the File tab. 

Step2: Select the New option. 



Step3: Now, choose the Blank document.  

A new blank document will appear on the screen. 

5. There are two scroll bars in the Word window: Vertical scroll bar 
and Horizontal scroll bar.​ ​ ​ ​ ​  

¤ The vertical scroll bar is located to the right of the document 
window. It is used to move the document up and down. 

¤ The horizontal scroll bar is located at the bottom of the document 
window. It is used to move the document left or right.  

6. The various parts of the Word 2016 window are :  

1. Quick Access Toolbar, 2. Title bar, 3. Ribbon, 4. Work Area, 5. Scroll 
Bar, 6. Status Bar  



Chapter 5 
 

A. Fill in the blanks with the help of the words given in the box.  
1. font 2. enter 3. left 4. ctrl+a 
B. Write true (T ) or false (F).  
1. T 2. T 3. F 4. T 
C. Tick (✓) the right answer.  
1.(iii) 2.(iii) 3.(i) 4. (ii) 
D. Answer the following questions.  
1. The majority of text-related tasks in Word are done in two steps: 
Step 1: Selecting the text.​
Step 2: Applying the necessary changes.  
There are two options for selecting text in Word 2016. We can select 

all of the text in a document or just a section of it using the keyboard 

or mouse. We can also select text or items that are in different places 

in the document.  

Selecting Entire Text  

To select all the text in a document follow the given steps:  

Step 1: Click anywhere in the document.​
Step 2: Press Ctrl + A on the keyboard. It will select the entire text in 

the document. 

Selecting the specific Text  

We also have a choice to select a specific word, line or paragraph. To 

select the specific text in the Word, follow the given steps:  

Step 1: Place our cursor in front of the first letter of the word, 

sentence or paragraph we want to select.  

Step 2: While dragging the pointer, press the Shift key to select the 

text we want.  



2. Text formatting involves changing how the text appears and is 

organised. The following steps will show how to format our text:  

Step 1: Select the text to which the effect should be applied before 

anything else.  

Step 2: Choose the Home tab.  

Step 3: Choose the Bold, italic or underline buttons from the Font 

group.  

We can also add some beautiful effects to the text, align the text, 

apply border and shade and much more. ​  

3. Calibri (Body) with a font size of 11 by default.  
 To change the font type, follow the given steps :  

Step 1: Select the desired text.  

Step 2: Choose the Home tab.  

Step 3: Click on the drop-down arrow next to the Font group's Font 

box to select it. The fonts will be listed.  

Step 4: The font you want to use for your text. The text will be in  

the font you choose.  

4. Alignment in a document describes where the text is located or 
how it appears in reference to the margins. There are four alignment 
options in Word. There are Left, Right, Justify and Center.  
To change the alignment of the chosen text, follow the given steps:  

Step 1: Select the text first.  

Step 2: Choose the Home tab.  

Step 3: Decide which alignment option you wish to utilise for the 

paragraph group in your content. The text will be aligned according 

to the selection.  



Left Align: When you select the Align Left button, the text is aligned 

to the left margin.  

Right Align:  When you select the Align Right button, the text is 

aligned to the right margin.  

Justify: When you select the Align Justify button, the text is centred 

between the left and right margins.  

Centre Align:When you select the Align Centre button, the text is 

aligned centred.  

 
5. Each item in a list is indicated by one of a small set of symbols 
called a bullet. To add bullets to a chunk of text, follow the given 
steps:  
Step 1: Select the text first. 

Step 2: Choosing the Home tab. 

Step 3: Choose Bullets under the Paragraph group.  A bullet library 

will appear.  

Step 4: Select the type of bullets you want to apply.  



Chapter 6 
 

A. Fill in the blanks with the help of the words given in the box.  
1. network 2. WWW, Web 3. Homepage 4. modulator demodulator 5. 
Mozilla firefox 
B. Write true (T ) or false (F).  
1. T 2. T 3. T 4. T 5. F 
C. Tick (✓) the right answer.  
1.(i) 2.(i) 3.(iii) 4. (i) 
D. Answer the following questions.  
1. Internet stands for International Networks. A computer network 
means computers connected to each other by telephone wire, 
satellites, or through other means.  
The internet is a communications system that connects computer 

and computer networks all over the world. Every kind of information 

is available on it. All computers that are a part of the internet can 

communicate and share information with one another. The Internet 

is also popularly known as Net. It is a network of networks.  

2. Four uses of internet are: 

(i) Online Education : Online education through e-learning websites 

has made education easily accessible. The Internet provides all the 

study material and information.  

(ii) Communication : We can chat with people and send e-mails 

having text, graphics, sound and videos anytime and anywhere. 

Example : facebook, instagram, twitter, whatsapp, gmail, outlook, 

etc. 

(iii) Shopping : We can do shopping on the Internet. The purchased 

things will be delivered to our home. We can also buy or sell old and 

new goods through internet services. Example : myntra.com, 

olx.com, jabond.com, ebay.com, etc.  



(iv) Searching : We can get information on any topic. There are 

various websites available for searching information.  

3. A website is a collection of web pages containing related 
information such as a person, business organization, educational and 
games institutes. Every website has its own identity called its website 
address. The first page of a website is called Home Page. Type the 
website address of your favourite site in any internet browser and 
the website will open. A website is like a book that contains many 
pages. 
  
4. In order to connect the computer to the Internet, we need a 
connection from an ISP. Internet Service Provider or ISP is a company 
that provides Internet access to users. Some Internet Service 
Providers are BSNL (Bharat Sanchar Nigam Ltd.), VSNL (Videsh 
Sanchar Nigam Ltd.), etc.  
 
5. A web browser is a software that is used to access information on 
the Internet. In other words, the website opens in and works through 
a web browser. Some popular web browsers are : Internet Explorer, 
Google Chrome, Mozilla Firefox, Opera, Apple Safari and Netscape 
Navigator etc.  



Chapter 7 
 

A. Fill in the blanks with the help of the words given in the box.  
1. block 2. Costumes 3. Orange cat 4. backdrops 
B. Write true (T ) or false (F).  
1. T 2. T 3. F 4. T 5. T 
C. Tick (✓) the right answer.  
1.(i) 2.(ii) 3.(iii) 4. (iii) 
D. Answer the following questions.  
1. The actor is the one who performs on stage. A Sprite is a Scratch 
item that has the same purpose on the stage. An orange cat serves as 
Scratch's default Sprite. 
 
2. (i) Stage Area : Everything happens in this area, which is 

comparable to a stage in a play. You can watch movies, play video 

games and present your original stage productions.  

(ii) Block Menu : Based on their use and function, the categories of 

blocks are displayed. The blocks in the same category all have the 

same colour, making it easier to distinguish between them in a 

program.  

(iii) Coding Area : The region where you stack your blocks to 

construct scripts is known as the "coding Area" or "scripts area." A 

Project that includes a script will be stored along with it. Each block 

in a script runs from top to bottom when we click on it.  

3. Motion blocks are those that are utilised to direct the movement 
of a Sprite. They have a blue hue. For instance, a Sprite can be moved 
using the motion block.  
The sprite will advance by 10 steps in this scenario. The number of 

steps is mutable. As demonstrated below, place a minus sign (-) 

before the number to make the Sprite move backward. This will 

cause the Sprite to walk 30 steps back from the sign.  



  
4. The costumes Tab allows you to add and modify the sprites' and 
backgrounds visual elements. 

​​The sprites' appearance can also be modified. To do so, follow the 

given steps:  

​​ Step 1: Select the Costumes tab. The tab displays an image of the 

selected sprite. Cat is the chosen sprite in this case.  

​​ Step 2: Select the sprite's picture by clicking on it. To choose the cat, 

drag the blue selection border. It has a border around it. 

​​ Step 3: Click on the Fill and Outline options to change the colors and 

outline of the cat.  



Chapter 8 
 

A. Fill in the blanks with the help of the words given in the box.  
1. decision-making 2. AI 3. narrow AI 4. strong AI 5. Robots 
B. Write true (T ) or false (F).  
1. T 2. F 3. T 4. F 5. T 
C. Tick (✓) the right answer.  
1.(iii) 2.(i) 3.(iv) 4. (i) 
D. Answer the following questions.  
1. AI is the branch of computer science that focuses on developing 
machines which can think and work like human beings. These 
machines are created to be smart and would be able to simulate the 
human thinking process. 
 
2. Three advantages of AI: 
1. AI helps in reducing human error : It is human nature to make 

mistakes. We humans make mistakes and then learn from our 

mistakes. However, machines are rarely wrong. Therefore, we can say 

that AI solutions cannot make mistakes. For example, self-driving cars 

can even help in saving human lives by limiting the cases of 

accidents.  

2. AI helps in reducing cost : AI applications, such as robotic arms 

used in manufacturing, process a huge amount of work quickly, 

resulting in cutting down various expenses such as manpower cost 

and production cost.​
3. AI performs repeated tasks without getting tired or bored : AI 

devices can carry out repeated tasks in an efficient and effective 

manner without getting tired or feeling bored like humans.  

3. Three disadvantages of AI are as follows:  



1.​Highly expensive : AI solutions are very expensive, as they are 

quite complex. The cost of maintaining and upgrading AI 

solutions is also high. Thus, AI solutions cannot be afforded and 

used by more people.  

2.​Cannot exhibit human emotions : AI systems do not have 

feelings and emotions like humans. These are based on logic, 

whereas many times we have to consider such factors while 

making decisions.  

3.​AI cannot learn with experience and has no decision-making 

capacity : We humans learn from our mistakes and past 

experiences, but this is not the case with AI. AI devices perform 

the same function repeatedly if no different command is given. 

Although AI solutions can store and process a lot of data, these 

do not have any decision-making capacity. 

 
  
4. AI can be classified into 3 categories which are based on the 
functionality of AI applications.   
 
1. Weak AI  

Weak AI is also known as Narrow AI. It is the most common type of AI 

that we can see and use all around us. One characteristic of this AI is:  

1.​Narrow AI performs dedicated tasks with Intelligence.  

2. Strong AI  

Strong AI is also termed as General AI. Machines with the following 

characteristics will fall in this category:  

1.​These machines have human-like intelligence.  



3. Super AI  

Super AI's are in their hypothetical stage. Following are the 

characteristics of Super AI.  

1.​These systems would be completely autonomous and won't 

require any kind of human interference.  

5. Artificial intelligence (AI) is used in many areas of our lives. Here 

are some common uses:  

Healthcare : AI helps in diagnosing diseases, analysing medical 

images and developing personalized treatment plans. 

Helping with Homework : AI powered apps can help students 

with their math problems and grammar checks. 

Smart Assistants : Devices like Alexa or Google Home can 

answer questions, play music, and even set reminders. 

Transportation : Self-driving cars used AI to navigate and ensure 

safety on the roads. 

Entertainment : AI recommends movies, music and shows 

based on your preferences like Netflix or Spotify. 

Robots : AI allows robots to perform tasks like cleaning, 

assembling products or exploring dangerous places. 



Customer Service : AI chatbots can answer questions and help 

solve problems when people visit websites. 

Education : AI -powered apps can help students learn by 

providing personalized exercises and feedback. 

AI in Mathematical computations : AI is used for solving 

complex mathematical problems such as proving theorems, 

differential and integral calculus etc. 

 



 
Book 4 

Chapter 1 
 

A. Fill in the blanks with the help of the words given in the box.  
1. Nibble 2. Bit 3. CPU 4. Primary Memory 
B. Write true (T ) or false (F).  
1. T 2. F 3. F 4. T  
C. Tick (✓) the right answer.  
1.(ii) 2.(ii) 3.(iii) 4. (i) 
D. Answer the following questions.  
1. A bit (short for binary digit) is the smallest unit of data in a 
computer. A bit has a single binary value, either 0 or 1.  
 
2. Primary memory is also known as the internal or main memory. A 
computer cannot run without the primary memory. It is used to store 
data or information that the CPU needs to access directly and quickly.  
 
The Primary memory can be divided into two parts:  

¤ RAM (Random Access Memory)​
¤ ROM (Read only Memory)  

3. Difference Between RAM and ROM 
​ ​ ​ ​  
​ ​ ​  
​ ​ ​  

RAM 
ROM 



​  

1.​Random Access Memory.​
 ​ ​ ​ ​  

2.​Both read and write operations 
are allowed.​
 ​ ​ ​ ​  

3.​All the instructions and data are 
stored inside this area before 
being processed.​
 ​ ​ ​ ​  

4.​RAM is a volatile memory. 

​ ​  

Read Only Memory.​  

Only read operations are 
allowed.​
 ​ ​ ​ ​  

Contains the instructions 
that are required by the 
computer to start. - .. .​
  

ROM is a non-volatile 
memory.​ ​ ​
​  

  
4. Computer memory is very similar to the human brain. It is used to 
store data and instructions given to it. It can store the information 
either temporarily or permanently.  
In computers, memory is a device that is used to store information.  

A computer can store the program in its memory. When a certain 

program starts on the computer, first of all, it is loaded into the 

computer’s memory. A computer can load many programs in its 

memory.  



Chapter 2 

A. Fill in the blanks with the help of the words given in the box.  
1. This PC 2. thumbnail 3. Ctrl+x, Ctrl+v 4. Folder 
 
B. Write true (T ) or false (F).  
1. F 2. T 3. F 4. T  
 
C. Tick (✓) the right answer.  
1.(iv) 2.(ii) 3.(iii) 4. (iii) 
 
D. Answer the following questions.  
1. This PC icon shows all the files and folders on your computer. It is 
also known as File Explorer where you can create, rename, copy, 
move, delete and search files and folders.  
 
2. The Recycle Bin keeps all of the files and folders that we delete. 
You can retrieve a file or folder from the Recycle Bin if you 
accidentally delete it.  
 
3. To create a folder on the desktop, follow the given steps:  

​​ Step 1: At a blank spot on the desktop, right click. A pop-up menu 

will appear.  

​​ Step2: Place your cursor over the New option. A submenu shows 

up.  

​​ Step 3: Select the Folder option. Another folder icon with the name 

New Folder shows up on the desktop.  

You can click anywhere outside the icon or type a name of your 

choice and press the Enter key. The folder icon displays the new 

name.  



4. A collection of data and information on a storage device like a hard 

disk, pen drive, CD or DVD is called a file. Document, file, Excel file, 

PowerPoint file, image file, music file, video file and so on  

are examples of the various types of files. Each type of file has its 

own distinct icon. Simply looking at the icon enables us to determine 

the type of file.  

We can use the Search box on the Start menu to find files, folders 

and programs stored on our computer. To find an item using the start 

menu we follow the procedure given below :  

Click the Start button and then type a word or a part of the word in 

the Search box.  

Search results appear as soon as you start typing in the search box.  

As we type, items that match our text will appear on the Start menu.  

 



Chapter 3 

A. Fill in the blanks with the help of the words given in the box.  
1. Column 2. pictures 3. Insert 4. merge cells 
 
B. Write true (T ) or false (F).  
1. T 2. T 3. F 4. F  
 
C. Tick (✓) the right answer.  
1.(iii) 2.(ii) 3.(i)  

 
D. Answer the following questions.  
1. WordArt is a special effect that alters the appearance of text in 
Word. Text that has been adapted to shapes. Shapes can be 
shadowed, skewed or stretched. WordArt gives you the ability to 
create effects on text that font formatting does not.  
 
2. In Word 2016, we can use a set of pre-built shapes in our 
documents. Shapes can be resized, rotated, flipped and coloured. 
Lines, basic shapes, flowchart elements, stars and banners and 
callouts are just a few of the many types of shapes that can be found 
in the Shapes command.  
Follow these steps to create a shape:  

Step 1: Select the Insert tab.  

Step2: Click on the Shapes option in the Illustration group. All of the 

shapes we can use to insert into our document appear in a 

drop-down list.  

Step 3: From the shapes that are available, choose any shape. 

Step 4: To draw the Selected shape, move the pointer within the 

document area and release the mouse button when the shape 

reaches the desired size. 

  



 
3. The document can contain images from the Internet. Follow the 
given steps to add pictures to our Word File:  
 
Step 1: Place the cursor where we need to insert the image. Select 

the Insert tab.  

Step 2: Within the Illustrations group, click on the online Pictures 

command. A submenu pops up.  

Step3: The dialog box for Insert Pictures​
appears. In the Bing Image Search box, enter a word.  

Step 4: The dialog box of Online Pictures appears. Choose the image 

we want to use. Click the Insert button. 

 
4. To remove a row, column or cell from a table, follow the given 

steps:  

Step 1: From the tables, select the rows, columns or cells you want to 

delete.  

Step 2: Under the Table Tools, select the Layout tab. 

Step 3: Click on the Delete option from the Rows & Columns group. 

Step 4: A menu with options appears. Choose the option you want. A 

dialog box titled Delete Cells appears when you select the Delete 

Cells option. Select rows, columns, or cells to be deleted from the 

table.  



Chapter 4 

A. Fill in the blanks with the help of the words given in the box.  
1. sequence 2. slides 3. status bar 4. .pptx 5. placeholders 
 
B. Write true (T ) or false (F).  
1. T 2. F 3. F 4. F 5. T  
 
C. Tick (✓) the right answer.  
1.(ii) 2.(i) 3.(ii) 4.(iii)  

 
D. Answer the following questions.  
1. A presentation has a number of sheets. These sheets are called 
Slides. Each sheet contains some information. Displaying multiple 
slides together in a sequence is called a Slide show. 
 
2. A presentation is a representation of an idea or information using 
text, curves, graphs, videos, clip art, picture and sound clips etc. A 
presentation has a number of sheets. These sheets are called Slides. 
Each sheet contains some information. Displaying multiple slides 
together in a sequence is called a Slide show. 
  
 
3. We are well familiar with handling text in Word 2016. But it is also 
very important to present textual data using effective tools. For this 
purpose, MS Office 2016 suite is embedded with a tool called 
PowerPoint 2016.  
 

A Presentation Graphics Software is a category of an application 

program which helps to create computer based presentations and 

also present the information in an interesting manner. It also helps in 

creating different types of slide shows and reports.  

PowerPoint 2016 helps the user in presenting an idea or information 

to others through a presentation.  



 
 
4. Five components of powerpoint 2016 windows are: 

1. Ribbon  

The Ribbon is present below the tabs. It 

contains various tabs and each tab contains a 

group of options.  

2. Status Bar  

The Status Bar is a horizontal bar at the bottom 

of the presentation. A Status bar shows the 

current slide number, number of slides, View 

buttons and Zoom slider.  

3. Dialog box  

The Dialog box launcher is an arrow that 

appears at the bottom-right launcher corner in 

some groups. Clicking on this opens a related 

dialog box with more options related to that 

group.  

4. Slides/Outline  
It shows all of the slides in the presentation as 

small pictures (called pane thumbnails).  

5. Notes pane  

The notes pane helps to add notes to each 

slide. These notes are very helpful to add 

additional information to a slide.  

 

 5. To insert a new slide in your presentation, follow these steps:  

Step 1: Click on the Home tab.  

Step 2: Then, on the Slides group, click on the New Slide option 

Step 3: A collection of slides will appear. Choose a Blank Slide. A new 

slide is inserted.  



Chapter 5 

A. Fill in the blanks with the help of the words given in the box.  
1. URL 2. Google Chrome, Internet Explorer 3. World Wide Web 4. 
Website 
 
B. Write true (T ) or false (F).  
1. F 2. T 3. F 4. T 5. F  
 
C. Tick (✓) the right answer.  
1.(iii) 2.(iii) 3.(i) 4.(iii)  

 
D. Answer the following questions.  
1. An Internet is a huge network of interconnected computer 
networks that spread all over the world. It is popularly called the 
'Net' :  
Internet stands for International Network of Interconnected 

Network or you can say “Network of Networks”. Millions of 

computers connected around the world through telephone lines, 

radio waves and satellites.  

2. There are various important uses of the internet. Some of the uses 
of the Internet are :  
¤ Allows us to send and receive messages anytime and anywhere.​
¤ Used for development and research.​
¤ Used in education  

¤ Performs banking operations.​
¤ We can chat with people on the Internet.​
¤ It is used to buy or sell new/old goods and services.  

¤ To buy airline/railway/movie tickets.​
¤ To check exam schedules and results.​
¤ To quickly provide information/news on any topic.  

 



3. If we want to find a particular chapter in a book, we would see the 
Index, find out the page number and then open that page. Similarly 
to look for any information on the Internet Search engines are used.  
Search engines allow the user to enter a keyword related to the 

information we require and search for the desired website containing 

a particular information.  

Example of Search engines are :  

Google : http://www.google.com  

Bing : http://www.bing.com  

Yahoo : http://www.yahoo.com  

 
4. We can use email to :  

¤ Send and receive messages : You can send an email to any person 

who has an e- mail address. The message arrives in the recipient's 

email inbox within seconds or minutes irrespective of his location. 

You can receive messages from anyone who knows your email 

address. You can also read and reply to those messages.  

¤ Send and receive files : In addition to the normal text based email, 

you can send almost any type of file through an e-mail including 

documents, pictures, and music. A file sent through an email is called 

an Attachment.  

¤ Send Messages to a group of people : We can send an email to 

many people at the same time.  

¤ Forward Message : When you receive an email, you can forward it 

to others without retyping it.  

¤ Sending an email is free : Unlike sending a regular letter, an email 

does not require a stamp of fee from the town where the recipient 



lives. Only Internet charges you have to pay for the Internet 

connection.  

 

 5. E-Mail stands for Electronic Mail. It is one of the most widely used 

applications on the Internet. It is a fast and convenient way to 

communicate with others.  

6. 1.Google Chrome 2. Internet Explorer 3. Safari 4. Opera  



Chapter 6 

A. Fill in the blanks with the help of the words given in the box.  
1. motion 2. sprite 3. sound 4. event 
 
B. Write true (T ) or false (F).  
1. T 2. T 3. F 4. F  
C. Tick (✓) the right answer.  
1.(i) 2.(ii) 3.(i) 4.(ii)  

 
D. Answer the following questions.  
1. Think block under looks group adds the specified text and a 
thought bubble to the Sprite for the Specified amount of time in 
seconds.  
 
2. An event is something that happens because of something else 
that happened before it. So if a particular action is performed, the 
events block actually controls how the blocks in a script will begin to 
run. Events and script start-ups are controlled by events and blocks. 
They are yellow in variety. When the Go button or the green flag is 

clicked, a block starts the script. 

  block puts the script into action when the selected 
key is pressed. You can select any option or any of the keys that have 
been provided. 

When you click the sprite,  block turns on the Sprite. 

  

 
  
 



3. When the same blocks need to be repeated multiple times, they 
have looping blocks. The control blocks that are used the most are: 

Wait block,  this block stops the running of the content for the 
number of seconds given in the block. You can utilize this block when 
two, move or talk, blocks are coming consistently. 

A set of blocks is repeated a certain number of times with the  repeat 
block. This block is too used to draw shapes where we need to give 
similar blocks over and over at various times. 

Until the stop button is pressed, the forever block continues to 
repeat a set of blocks. Similar to the repeat block, this one 
automatically expands to accommodate the blocks you snap inside it.  

 
 
4. Do Yourself  



Chapter 7 

A. Fill in the blanks with the help of the words given in the box.  
1. green 2. repeat 3. duplicate 4. two-dimensional 
 
B. Write true (T ) or false (F).  
1. F 2. T 3. T 4. F  
C. Tick (✓) the right answer.  
1.(ii) 2.(ii) 3.(i) 4.(i)  

 
D. Answer the following questions.  
1. The colour of the Pen blocks is green. As the Sprite moves around 
the stage, these blocks leave a trail. You can change the colour of the 
pen. Pen Blocks must be added to the block category in Scratch 3.0.
​ ​ ​ ​ ​ ​  

To add a Pen Block, follow the given steps: 

Step 1: The “Add Extension button” can be found in the Code tab in 
the lower left corner, when we click on it “Choose an Extension 
window” appears.​
Step 2: Click on the Pen option. The Code tab now has the Pen 
blocks. 
 
 

Erase all Everything drawn by the pen is erased by erasing all 
blocks. 

Stamp A duplicate of the current Sprite is made when you click 
on the stamp block. On the stage, the image is stamped. 
Drag the Sprite in order to view the image. A copy of 
the Sprite shows up behind it. 

Pen Up The pen up block stops the Sprite from drawing 
anything by raising the pen. 

Pen Down Use the pen down block to draw a continuous line 
wherever it moves. 



Set Pen 
color to 

Use set pen color to block to set the colour of the pen 
to a colour of your choice from the drop-down menu. 

Change pen 
color by 

This block changes the pen colour, saturation, 
brightness and transparency. Click on the first test box 
to select and change the pen effects. To enter a value 
that will alter the effect, click the second text box. 

 
 
2. When clicked>pen down>Repeat 40> move steps1 

3. Triangle (3 sides), Square (4 sides), pentagon(5 sides) 

 
4. The pen up block stops the Sprite from drawing anything by raising 

the pen. 

 



Chapter 8 

A. Fill in the blanks with the help of the words given in the box.  
1. halt 2. commander 3. RT command 4. pause 
 
B. Write true (T ) or false (F).  
1. T 2. F 3. T 
C. Tick (✓) the right answer.  
1.(ii) 2.(i) 3.(i) 4.(iv)  

 
D. Answer the following questions.  
1. The colour of the Pen blocks is green. As the Sprite moves around 
the stage, these blocks leave a trail. You can change the colour of the 
pen. Pen Blocks must be added to the block category in Scratch 3.0.
​ ​ ​ ​ ​ ​  

To add a Pen Block, follow the given steps: 

Step 1: The “Add Extension button” can be found in the Code tab in 
the lower left corner, when we click on it “Choose an Extension 
window” appears.​
Step 2: Click on the Pen option. The Code tab now has the Pen 
blocks. 
 
 

Erase all Everything drawn by the pen is erased by erasing all 
blocks. 

Stamp A duplicate of the current Sprite is made when you click 
on the stamp block. On the stage, the image is stamped. 
Drag the Sprite in order to view the image. A copy of 
the Sprite shows up behind it. 

Pen Up The pen up block stops the Sprite from drawing 
anything by raising the pen. 

Pen Down Use the pen down block to draw a continuous line 
wherever it moves. 



Set Pen 
color to 

Use set pen color to block to set the colour of the pen 
to a colour of your choice from the drop-down menu. 

Change pen 
color by 

This block changes the pen colour, saturation, 
brightness and transparency. Click on the first test box 
to select and change the pen effects. To enter a value 
that will alter the effect, click the second text box. 

 
 
2. Input Box : In this box, we type commands and execute them by 
pressing the Enter key or clicking the Execute button. This is the area 
where we type the instructions for the turtle.  
 
3. FORWARD (FD) 
Forward means moving ahead. This moves the turtle forward in the 
direction of its head. 
Example: 
Type in the input box:  
FD 100 
Press the Enter key or click on the Execute button. 
The turtle moves 100 steps ahead on the screen 
  
  
RIGHT TURN (RT) 
It turns the turtle's head in the right direction by the angel 
mentioned. 
Example: 
Type in the input box:  
RT 70 
Press the Enter key or click on the Execute button. 
The turtle's head turns in the right direction at 70 degrees. 

 



 

Chapter 9 

A. Fill in the blanks with the help of the words given in the box.  
1. autonomous driving 2. facial 3. radar 4. security 5. natural 
 
B. Write true (T ) or false (F).  
1. F 2. F 3. T 4. T 5. F  
C. Tick (✓) the right answer.  
1.(iii) 2.(iv) 3.(iii) 4.(iii)  5. (iv) 
 

D. Answer the following questions.  
1. Alexa is one of the devices that is gaining immense popularity 
among users and is becoming a household gadget. Alexa uses NLP 
(Natural Language Processing) to interpret voice commands and 
converts them into text commands and routes that interpret 
commands to the cloud service. 
Here are some key features that describe Alexa: 
1. Voice-activated : Alexa responds to voice commands, allowing you 
to interact with her hands-free. 
2. Smart speaker integration : Alexa is integrated into Amazon Echo 
smart speakers, such as the Echo, Echo Dot, and Echo Show. 
3. Voice recognition : Alexa uses natural language processing (NLP) to 
recognise and understand voice commands. 
4. Skills : Alexa has thousands of skills, which are third-party 
developed capabilities that can be enabled to perform specific tasks, 
such as: 
¤ Controlling smart home devices (e.g., lights, thermostats) 
¤ Playing music and media 
 
 
2. Smart Doorbells represent a significant advancement in home 
security and convenience, leveraging artificial intelligence (AI) to 
enhance traditional doorbell functionality. Equipped with modern 
features such as video streaming, motion detection and two-way 



audio communication, smart doorbells provide homeowners with 
greater control and awareness of their front door activity. Two 
features of smart doorbell are: 
Security and Privacy 
With the increased use of AI and connectivity, security and privacy 
are paramount concerns for smart doorbell users. Data encryption 
helps protect the video footage and personal information 
transmitted and stored by these devices. Manufacturers must also 
address user privacy by ensuring that data collection is transparent 
and compliant with legal standards. 
Future Prospects 
The future of smart doorbells looks promising as AI technology 
continues to evolve. Upcoming advancements may include even 
more sophisticated facial recognition, better integration with other 
smart home devices, and enhanced user experiences. As AI becomes 
more advanced, smart doorbells will likely offer greater convenience, 
security and functionality. 

  

  

 

3. Face Detection algorithms typically follow these steps: 

1.   Image Acquisition : Capturing the image or video frame 
containing human faces. 

2.   Pre-processing : Enhancing image quality and converting it to 
a suitable format for analysis. 

3.   Feature Extraction: Identifying facial features such as eyes, 
nose and mouth using techniques like Haar cascades, 
Histogram of Oriented Gradients (HOG) and deep leaning 
models. 

4.   Classification: Differentiating faces from non-face objects 
using machine learning classifiers or convolutional neural 
networks (CNNs). 



5.   Localization: Drawing boundary boxes around detected faces 
to indicate their positions in the image. 

 
4. Chatbots are AI -powered software applications designed to 

simulate human conversation. They can interact with users through 

text or voice, providing information, answering questions and 

performing tasks. Chatbots are widely used in customer service, 

healthcare, e-commerce and many other fields. ​ ​ ​ ​  

Types of Chatbots : The types of chatbots are as follows: 

1.​Rule-Based Chatbots : Operate on predefined rules and scripts. 

They follow a decision tree to respond to specific inputs but 

lack flexibility.​
 ​ ​ ​ ​ ​ ​  

2.​AI-Powered Chatbots : Uses machine learning and NLP to 

understand and respond to a wider range of inputs. These 

chatbots can learn from interactions and improve over time.​
 ​ ​ ​ ​ ​ ​  

3.​Hybrid Chatbots : Combines rule-based and AI approaches, 

using predefined rules for common queries and AI for more 

complex interactions. ​
 ​ ​ ​ ​ ​ ​  

​ ​  ​  ​  ​ ​  

​ ​ ​  

​ ​ ​ ​  

​ ​ ​ ​ ​  

Benefits of Chatbots : Following are the benefits of Chatbots: 

​ ​ ​ ​ ​  



1.​24/7 Availability : Providing assistance and information at any 
time.​​ ​ ​ ​ ​  

2.​Cost Efficiency : Reducing the need for human customer service 
representatives.​
 ​ ​ ​ ​ ​ ​  

3.​Scalability : Handling multiple conversations simultaneously 
without compromising quality.​
 ​ ​ ​ ​ ​ ​  

4.​Consistency : Delivering uniform responses, reducing the 
chances of human error.  

5. Self-driving vehicles, also known as autonomous vehicles, are at 

the forefront of artificial intelligence (AI) applications in 

transportation. These vehicles are designed to navigate and operate 

without human intervention, utilizing a combination of sensors, 

cameras, radar, and advanced AI algorithm to perceive their 

environment, make decisions and drive safely. 

Key Components: Self-Driving vehicles rely on several critical 

components to function effectively: 

 

1.   Sensors and Cameras : These provide a 360-degree view of 

the vehicle's surroundings, detecting obstacles, road signs, 

and other vehicles. 

2.   Radar and Lidar : These technologies measure distances and 

create detailed maps of the environment, helping the vehicle 

understand its position relative to other objects. 

3.   AI Algorithms : Machine learning and deep learning 

algorithms process the data from sensors and cameras, 

enabling the vehicle to recognise objects, predict their 

movements and make driving decisions.  



Book 5 
Chapter 1 

A. Fill in the blanks with the help of the words given in the box.  
1. Artificial Intelligence 2. Blaise Pascal 3. Abacus 4. tabulation 
Machine 
 
B. Write true (T ) or false (F).  
1. F 2. T 3. T 4. F 
 
C. Tick (✓) the right answer.  
1.(iii) 2.(ii) 3.(i) 4.(ii)   
 

D. Answer the following questions.  
1. In 1672, Gottfried Wilhelm von Leibniz invented the stepped Reckoner. 
This was commonly referred to as the Leibniz Calculating Machine. It 
could perform all four arithmetic operations.  
 
2. Fourth Generation(1971-1980)​ ​ ​ ​  

●​ The fourth-generation computers are based on very large scale 
Integrated (VLSI) circuits, called microprocessors. 

●​ These computers can share storage space, data and other 
resources with each other. 

●​ These computers are the cheapest among all other generations. 
●​ IBM PC and Apple Macintosh are examples of fourth 

generation computers. 

3. Abacus-first Calculating Device 

Almost 5000 years ago, the counting frame was developed by Sumarian 
civilization. This was commonly known as the Abacus. This device had 
rods and beads in it and was the first calculating device made. It was used 
to count numbers. It is still used in some parts of Asia and Africa.  

Pascaline Adding Machine  



In 1642, Blaise Pascal invented the machine named “Arithmatique”. This 
machine was commonly known as Pascal's Adding Machine, Pascaline or 
Numerical Wheel Calculator. This machine had eight movable dials. This 
machine was used to do only addition and subtraction; therefore, it was 
not very popular.  

 
4. As the name suggests, these are the most powerful computers in the 

world. They are used for special purposes. They handle most complex 

scientific, statistical applications and programs. 

Key features: 

¤  These computers use a very high level of technology. 

¤  They have very high memory capacity.  

¤ Data processing is ultra fast. 

¤  Highly sophisticated technology is used in these computers, e.g, parallel 

processing. 

¤  Cost varies from 1 million to 5 million dollars or more.  



Chapter 2 

A. Fill in the blanks with the help of the words given in the box.  
1. Portrait 2. Landscape 3. find command 4. paragraph spacing 5. 
footer 
 
B. Write true (T ) or false (F).  
1. F 2. F 3. T 4. F 5. T 
C. Tick (✓) the right answer.  
1.(iii) 2.(iii) 3.(i) 4.(ii) 5. (ii)   
 

D. Answer the following questions.  
1. Mail merge is a very important tool which allows us to create form 
letters, mailing labels and envelopes by linking a main document to a set 
of data or data source. The main document is linked to the data source by 
common fields of data, called merge fields.​ ​ ​ ​ ​  

For example, in a form letter, your main document would be the letter 
informing the parents to be called for an annual program. The data source 
is where the fields of information on each parent receiving the letter are 
located. The data source would contain names, addresses, phone 
numbers etc. 

If we were printing envelopes or address labels, the main document 
would be the envelopes or the sheet with labels on it; the data source 
would be the addresses that are to be placed on these envelopes or labels 
of sheets. 

When we are performing a Mail Merge, we will need a word document 
(we can start with an existing one or create a new one) and a recipient 
list, which is typically an Excel workbook.  

 
2. It is important to always check your documents for spelling and 
grammar mistakes before distribution. Fortunately, Word makes it easy.  

To run a Spelling and Grammar Check 

​ ​ ​ ​ ​ ​  



1. From the Review tab, click the Spelling & Grammar option.​ ​  

2. The Spelling and Grammar Pane will appear on the right. For each 
error in your file, Word will try to offer one or more suggestions. You can 
select a suggestion and click Change to correct the error.  

3. Word will move through each error until you have reviewed all of them. 
After the last error has been reviewed, a dialog box will appear as shown. 
Click OK.  

3. The Find and Replace command in Word allows you to search for target 
text and replace it with something else. To use Find command, follow the 
given steps: 

1.​Click on the Home tab.​
 ​ ​ ​ ​ ​ ​  

2.​Click on the Find option in the Editing group. A Navigation window 
will open on the left side.​
 ​ ​ ​ ​ ​ ​  

3.​Enter the word you want to search for in the box. Word searches for 
the text you entered and displays the result by highlighting the text 
in the document.  

4.​You can click the Close button to clear the search. 

To use Replace command, follow the given steps :  

1.​Select the Home tab.  

2.​Click the Replace option. The Find and Replace Box appears.  

3.​ In the Find what textbox, type the word that you want to replace.  

4.​ In the Replace with textbox, type the word that you want to replace 

it with.  

5.​Click the Replace option. 

 
4. Paragraph spacing means the amount of space above or below the 

paragraph. To use this option, follow the given steps:  

Step 1 : Select the desired paragraph 



Step 2: Click on the Paragraph dialog box launcher on the Paragraph 

group in the Home tab. A dialog box will appear.  

Step 3: Select the Indents and Spacing tab.  

Step 4: Select the spacing to be added before and after the paragraph in 

the Spacing option.  

Step 5: Click OK. 

 

5. Any information added at the top of the page is referred to as the 

Header and added at the bottom of the page is referred to as the Footer. 

It could be in the form of a picture, a date, a page number, a time etc.  

(i) The steps to insert a header in a word document, are as follow:  

Step1: Click on the Insert tab and then click on the Header option in the 

Header & Footer group.  

Step 2: A drop-down list will appear. Select a header style from it. 

Step3: We will find the Header box at the top of each page, separated by 

dotted lines.  

Step 4: Click on this box and type the text that we want to display. This 

will be applied to all the pages in the word document.  

 (ii) The steps to insert a header in a word document, are as follow:  

Step1: Click on the Insert tab and then click on the Footer option in the 

Header & Footer group.  

Step 2: Select a footer style from the drop down list. 

Step3: The footer will be displayed at the bottom of each page, separated 

by dotted lines.  

Step 4: Click on this box and type the text that we want to display. This 

will be applied to all the pages in the word document.  



To save the header and footer, click on the Close Header and Footer 

option from the Header & Footer Tools tab. To remove the header and 

footer, click on the Remove Header/Footer option from the drop-down 

list.  

 

Chapter 3 

A. Fill in the blanks with the help of the words given in the box.  
1. theme 2. format background 3. Insert 4. SmartArt  
 
B. Write true (T ) or false (F).  
1. F 2. T 3. F 4. F ​
 
C. Tick (✓) the right answer.  
1.(ii) 2.(i) 3.(i) 4.(iii)  
 

D. Answer the following questions.  
1. Themes are an in-built tool that allows you to quickly change the layout 
and look of the presentation you've made. Each theme has its own colour 
scheme, typefaces and effects.  
 
2. In PowerPoint, Slide Master is used to create the default arrangement 
and look of the slides in the presentation. When we add new slides to a 
presentation and use a slide layout, the slide is prepared automatically 
according to the slide master. 

Follow the steps below to change the backdrop of the slides: 

Step 1: Select the Design tab. 

Step 2: In the Customize group, select the Format Background command. 
On the right side of the window, a Format Background task pane appears. 
It offers four fill effects: solid, gradient, picture of texture and pattern. 

Step3: Select the desired fill choice by clicking on the radio button. 



3. PowerPoint animation effects are classified into four types. The 
categories are as follows: 

Entrance: This category contains effects that regulate the introduction of 
an object onto the slide. Some of its examples are: Appear, Fly In, Float In, 
Zoom etc. 

Emphasis: This category of effects is used to emphasise crucial points or 
items in a presentation. Some of its examples are: Pulse, Spin, Teeter, 
Desaturate, Lighten etc. 

Exit: This category contains effects that affect how an object exits the 
slide. Some of its examples are: Disappear, Fade, Fly Out, Wipe etc. 

Motion Paths: Like the Emphasis effect, the item within the slide moves 
along a route or pattern, such as a loop or a square. Some of its examples 
are: Lines, Arcs, Turns, Shapes, Loops etc. 

 
4. When we view an animated film, the scenes follow one another. There 

is no interval between the two scenes. A similar effect can be achieved in 

a PowerPoint presentation. A sliding transition can be used to generate 

this effect. Transition refers to how one slide follows another on the 

screen in a presentation. 

To use a slide transition, follow these steps: 

Step 1: From the Slide Navigation pane, select the slide to which we wish 

to apply the transition 

Step 2: Navigate to the Transition tab. 

Step 3: In the Transition To This Slide group, click the More option. 

A drop-down gallery with transition effect options appears. There are 

three types of transition effects available in PowerPoint. They are as 

follows: 



¤ Subtle: These transition effects are very basic and straightforward.​
¤ Exciting: These transition effects are more complicated than subtle 

effects. Transitions are strong in this area to show more graphic effects. 

¤ Dynamic Content: These are strong transition effects that only affect the 

content, such as text or graphics. If the slide layouts on this and the 

preceding slide are the same, dynamic transition will just move the 

placeholders. It has no effect on the slides. 

Step 4: Select a transition to apply to the currently selected slide. In the 

slide region, a preview of the transition effect displays.  



Chapter 4 

A. Fill in the blanks with the help of the words given in the box.  
1. text box 2. slide sorter view , normal view 3. text group 4. ctrl+M 5. 
ctrl+D 
 
B. Write true (T ) or false (F).  
1. F 2. F 3. F 4. T 5. T​
 
C. Tick (✓) the right answer.  
1.(i) 2.(iii) 3.(ii) 4.(ii)  
 

D. Answer the following questions.  
1. Slides contain placeholders, which are areas on the slide that are 
enclosed by dotted borders. Placeholders can contain many different 
items including text, pictures and charts. Placeholders are arranged in 
different layouts that can be applied to existing slides or chosen when we 
insert a new slide. A slide layout arranges our content using different 
types of placeholders, depending on what information we might want to 
include in our presentation. 
 
2. While adding textures and colours, you can apply shadow effects to the 
Shape or object. It will make the shapes look attractive. 
To do this follow the steps given below : 
 
Step1: Select a Shape object. 
Step2: Click on the Shape Effects button in the Shape Styles group on the 
Drawing Tools format tab and select the Shadow option. A drop-down 
menu will appear. 
Step3: Click on desired shadow effect in Shadow sub-options. 
 

3. To select multiple slides, we have to press and hold Ctrl on your 
keyboard and click the slides that we want to select. Multiple slides will 
be selected. 

4. The WordArt feature allows us to create stylized text with unique 

effects such as textures, shadows, and outline etc. 



To do this, follow the steps given below : 

Step 1 : Click on the WordArt button in the Text group on the Insert tab. 

Step 2 : WordArt gallery drop-down menu opens up on the screen. Click 

on the required thumbnail. A text box appears on the slide. 

Step3: Type FUN N LEARN in placeholder and select this text. 

Step4: Click on the Text Fill drop-down arrow in the WordArt Styles group 

on the Drawing Tools Format tab. Select the desired colour and observe 

the change. 

Step5: Click on the Text Outline drop-down arrow. Choose the desired 

outline colour from the displayed list. 

Step 6 : Now, click on the Text Effects drop-down arrow. Point to Glow 

option and click on the desired effect from the Glow Variations section. 

Step7: You will find a beautiful change in the text. 

5. The PowerPoint Shapes feature allows us to draw different shapes that 

we want. We can resize, rotate, flip and color any shape. 

To insert shape follow the steps given below :  

Step1: Click on the Shapes button in the Illustrations group on the Insert 

tab. A pop-up menu will display Option Lines, Rectangles, Flowchart etc. 

Step 2 : Point to Basic Shapes and move the pointer to select Smiley Face 

and click on it. 

Step3: The pointer changes to + sign. Place the pointer on the slide and 

drag it to adjust the size of the selected object/shape. 

Step4: To resize a shape, select the shape by clicking on it. It displays​
eight handles on the object. Place the mouse pointer on any handle. The 

pointer changes to a double-headed arrow. Drag the handle to increase or 

decrease the size.   



Chapter 5 

A. Fill in the blanks with the help of the words given in the box.  
1. spreadsheet 2. formula 3. worksheets 4. values 5. tabular 
 
B. Write true (T ) or false (F).  
1. F 2. F 3. F 4. T 5. T​
 
C. Tick (✓) the right answer.  
1.(iii) 2.(i) 3.(i) 4.(iv)  
 

D. Answer the following questions.  
1. A large sheet having data and information arranged in rows and 
columns is known as spreadsheet. Spreadsheets are useful in many fields. 
They are used in the business field and are also used for performing 
complicated calculations. 
 
2.  

Workbook Worksheet 

Excel documents are called a 
workbook. 

A large sheet having data and 
information arranged in rows and 
columns is known as worksheet 

A workbook is a collection of 
worksheets. 

A worksheet is a collection of rows 
and columns. 

A workbook contains worksheets. A worksheet may or may not 
contain data. 

The workbook will contain one or 
many worksheets. 

A worksheet has 65,356 rows and 
256 columns. 



3. Data are the facts about something that can be used in calculating, 
reasoning or planning. There are three types of data that can be entered 
in your worksheet. They are as follows. 

1. Numbers: Numeric data consists of numbers 0 to 9 and some 
characters like +, -, E, e, $, % etc. MS Excel can store up to a maximum of 
15 digits for each number that includes integers and decimals. The 
number of digits displayed after a decimal depends on the column width. 
If the width is not enough to fit all the numbers after the decimal, you 
may only see a couple of digits after the decimal. You can see the whole 
number in the formula bar. 

A series of hash sign (#) appears in the cell if you narrow the column 
width. To see the numbers in place of the sign, increase the column 
width. As the column width increases, more and more digits are 
displayed. 

2. Text: Any matter is text that includes numbers, spaces and non-numeric 
characters. Some examples are 123AB, 98-231, 43-931, 123ABC456. We 
cannot include text entries in calculations. 

3. Formulae: Excel allows you to use a special symbol, the equal sign(=), 
to indicate that you expect what you type next to be translated into a 
formula. Consider the following examples. 

(i) = 35+24                                                          ​ (ii) = A2+A5 

4.  ​​To enter the data in a cell, follow the given steps: 

Step 1: Click on the cell where you want to enter data. 

Step 2: Types the data into the cell. 

Step 3: Press Enter key to move to the next cell below the selected cell. 

When you type data in a cell the data also appears in the Formula box 

highlighting two buttons. 

❖​Cancel button: it is used to cancel data entry before pressing the 

enter key. 



❖​Enter button: it is used to accept data entry before pressing the 

enter key. 

5.  Cells are the boxes, in rectangular or in square shape, created by rows 

and columns when they intersect each other. Each cell has its specific 

address for reference. The address of a cell consists of a column letter 

followed by the row number.  



Chapter 6 

A. Fill in the blanks with the help of the words given in the box.  
1. overwriting 2. redo 3. autofill 4. left aligned  
 
B. Write true (T ) or false (F).  
1. T 2. T 3. F 4. T 5. T​
 
C. Tick (✓) the right answer.  
1.(i) 2.(i) 3.(i) 4.(i)  
 

D. Answer the following questions.  
1. Undo is a function performed to reverse the action of an earlier action. 
To undo, click the Undo button present on the Quick Access Toolbar. 

Redo is a function performed to reverse the action of an undo command. 
To Redo, click the Redo button present on the Quick Access Toolbar.  

 
2. The contents on the worksheet can be copied or moved to a different 
position on the same worksheet or on a different worksheet. 
Copying refers to duplicating data i.e., text, numbers, formulae, either in 
the same worksheet or in a different worksheet. Moving refers to 
changing the position of data either in the same worksheet or in a 
different worksheet. To move or copy data, use the Cut, Copy and Paste 
commands. These commands use windows clipboard. 
 
To move cell contents, follow these steps : 
 
Step 1. Select the cells you want to move. 
Step2. Click the Cut command. The border of the selected cells will 
change appearance. 
Step 3. Select the cell or cells where you want to paste the content. 
Step 4. Click the Paste command. The copied content will be entered into 
the highlighted cell. 
 
 



3. AutoFill is the most important feature of Excel. It allows you to create 
entire columns or rows based on data from another cell and not from the 
pattern. AutoFill feature allows you to enter a predefined series of data. It 
quickly fills cells with repetitive or sequential data such as dates or 
numbers and repeated text. Using this feature, you can copy functions 
and alter text or numbers. For example, January, February,......... 
December, 101, 102, ........etc. 
 
4.  ​​We can clear the contents of a cell and remove undesired contents. For 

this we have to follow the given steps: 

 Step 1: Select the cell that you want to delete. 

Step 2: On the Home tab, click on the Clear button from the Editing 

group. A drop-down list appears. 

Step 3: Click on the Clear Contents option from the dropdown list. 
  

 



Chapter 7 

A. Fill in the blanks with the help of the words given in the box.  
1. URL 2. 1969 3. ISP 4. E-mail  
 
B. Write true (T ) or false (F).  
1. F 2. T 3. F 4. T​
 
C. Tick (✓) the right answer.  
1.(i) 2.(i) 3.(i) 4.(i)  
 

D. Answer the following questions.  
1. A modem is a device that connects two or more computers together by 
means of a telephone line.  
 
2. The term E-mail stands for Electronic Mail. It is a quick way of sending 
messages to people using the Internet. It’s simplicity and affordability of 
sending mail on the Internet has totally replaced the corresponding postal 
system. 

An Email is sent to a person’s email address. An e-mail address is given in 
the format :       

User name  Symbol Domain name 

Knowlegetree2014  @ gmail.com 

   ​     ​ ​ ​    ​
The popular websites which provide the facility to send or receive mail 
are : www.gmail.com, www.google.com, www.rediff.mail.com etc. 

  
3. The Internet is a network which connects people from all over the 
world. The Internet was founded by the Department of Defence (DOD), 
USA. In 1969, scientists thought to create a network that could continue 
working​



even in a nuclear attack. Then, this network was known as ARPANET 
(Advanced Research Projects Agency Network). In 1980, National Science 
Foundation (NSF) linked five supercomputers in five universities to allow 
scholars to share information on the latest technology. Then it expanded 
gradually in businesses, government organisations, etc. and became the 
network all over the world which is known as the Internet. 
 
4.  ​​To use an e-mail facility, first you have to make your email account. To 

make email- account follow these steps : 

Step 1 : Connect to the Internet.​
Step 2 : Open the website www.google. co.in. Click on the Gmail link.​
Step 3 : Click on Use another account and then click on Create Account Ý 
For myself. 

Step 4 : A registration form appears. Fill in the registration form. Choose a 

Username and Password. 

Step 5 : Click on Next, enter your phone number to verify your account 

and some of your personal information, like your birthday. Google uses a 

two-step verification process for your security. You will receive a text 

message from Google with a verification code. Enter the code to complete 

the account verification. 

Step 6 : Next, you will see a form of Privacy and Terms click on I agree. 

Your account will be created.  



Chapter 8 

A. Fill in the blanks with the help of the words given in the box.  
1. ask 2. Variables 3. sensing 4. Hat 
 
B. Write true (T ) or false (F).  
1. T 2. T 3. T 4. F 
 
C. Tick (✓) the right answer.  
1.(iv) 2.(i) 3.(ii) 4.(iii)  
 

D. Answer the following questions.  
1. Hat Blocks, Stack Blocks, Boolean Blocks, Reported Blocks, C Blocks, 
Cap Blocks. 
 
2. A variable which stores letters in the form of strings or characters is 
called string variable. It can store names, words, sentences or numbers, 
which are enclosed in question marks. For example, ''Kavita'', '' I read in 
class 5'', ''78695''. These variables are not used in calculations. 
 
3. Scratch has two conditional blocks. These are: 

1. If then blocks : if the condition is true, the blocks inside the conditional 
block will run. If the condition is false, the blocks inside the conditional 
block will not run. Then only the blocks outside the conditional block will 
run. 

2. If, then....else block : if the condition is true, the blocks inside then 
condition will run, if the condition is false, the blocks inside the else 
condition will run. 

4.  ​​In Scratch, the blocks that sense the input from the keyboard or the 

mouse at the time of execution of a script, are called sensing blocks. A 

few of the sensing blocks and their functions are given below: 

·   ​ This block asks the user to type the input using the keyboard. It waits 

for the input from the user. No other block will run at that time. 



·   ​ This block monitors if the sprite touches the mouse- pointer, another 

sprite or the edge. If the answer is true, then it executes the blocks 

given after it in the program's condition. If false, then it executes other 

blocks as per the condition specified in the program. 

·   ​ This blocks monitors if the sprite is touching the colour chosen in the 

block or not. If true, then it executes a set of blocks, else executes 

another set of blocks. 

·   ​ This block monitors if the first chosen is touching the second chosen 

colour, if true, then it executes a set of blocks, else executes another 

set of blocks. 

·   ​ This block monitors if the chosen key is pressed or not by the user. If 

true, then it executes a set of blocks, else executes another set of blocks.



Chapter 9 

A. Fill in the blanks with the help of the words given in the box.  
1. AI 2. lighting 3. speakers 4. smart smoke detectors 
 
B. Write true (T ) or false (F).  
1. T 2. F 3. T 4. F 
 
C. Tick (✓) the right answer.  
1.(ii) 2.(ii) 3.(ii) 4.(ii)  
 

D. Answer the following questions.  
1. Smart TV : AI-enabled TVs are smart TVs. It can perform many tasks. It 
allows its users to play music, movies or change channels using the 
internet or your voice. 

Video Doorbells : Video doorbells allow the owners to watch who is 
outside the door before actually opening it and provide security. It has a 
built- in camera to watch and a microphone to talk to the visitor through 
the intercom. 

Smart Lighting :Smart lighting systems help in saving and conserving 
energy. The owners program to turn the lights on/off and control the 
brightness. 

2. Smart Smoke Detectors :Smart smoke detectors give an alarm when 
there is smoke. It can also warn the owners if there is a fire in the home. 
 
3. Smart TV : AI-enabled TVs are smart TVs. It can perform many tasks. It 
allows its users to play music, movies or change channels using the 
internet or your voice. 
 
4.  ​​The following are the benefits of a Smart Home: 

¤  Smart Home is great in saving electric power. For instance, when people 

often forget to switch off their lights. Smart Home can detect and switch 

off the lights.​



 ¤  It is also installed with smart security devices which help in keeping the 

home and its belongings safe and secure.  



 

  

 

  


